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Visible Systems
WELCOME TO VISIBLE LCSIS

VISIBLE LCSIS is a product data management software application developed to support 
and enhance product design and development, manufacturing, and in-service life cycle 
support. VISIBLE LCSIS was designed from conception to support sound configuration 
management principles and associated change control as well as provide rapid recovery 
and viewing of vaulted digital objects that identify and define configuration items.  
Through its graphical user interface design, VISIBLE LCSIS has the feel and look of the 
Windows environment while offering all of the advantages of client/server technology and 
relational data base architecture.

VISIBLE LCSIS was designed to create product baselines during initial product develop-
ment and, at the same time, provide a means for the permanent storage of digital data in 
predefined folders tied to each configuration item created in the design.  This unique 
design approach separates VISIBLE LCSIS from the majority of document management 
products offered today that are unable to create meaningful relationships between their 
product structures and their associated documentation.  Because of this unique relation-
ship, VISIBLE LCSIS is able to create and modify multiple baseline variants through a 
product’s life cycle and still maintain its relationship to its documentation.  As new base-
lines are added to create a variant of an existing product or modifications are made to 
existing life cycle baselines, documentation associated with configuration items is carried 
forward and maintained as revisions to existing documents.  New reference documents 
can be added to enhance each configuration item’s library of documents or they can be 
deleted if they become obsolete.

VISIBLE LCSIS offers users the ability to create four basic product baselines that are both 
relevant and meaningful during a product’s life cycle.  These baselines, defined by the 
Configuration Management Institute of America in conjunction with the University of 
Arizona are:  1) the Bill of Material (BOM); 2) the As-Planned; 3) the As-Built; and 4) the 
As-Modified.  Each baseline is extremely important because they each establish bench-
marks in a product’s life cycle that are used to coordinate such activities as long lead time 
procurements; baseline documentation requirements; defining the product to be built, and 
tracking the deployed product to support both out-year product liability issues and product 
upgrades.
LCSIS Administrator’s Application Guide- 1



VISIBLE LCSIS incorporates the advantages of client/server technology and relational 
database architecture in that it allows multiple users to access data simultaneously without 
affecting performance.  Additionally, VISIBLE LCSIS provides full system metrics for 
every action initiated by an authorized user.  By simply defining a given period of per-
formance, the system administrator can generate a summary of all actions undertaken for a 
particular time period.  VISIBLE LCSIS also monitors all action undertaken by the system 
administrator by automatically notifying each individual program manager, with a warn-
ing message, of every change action to the database that is initiated to his product by the 
system administrator.  In essence VISIBLE LCSIS is on guard twenty-four hours a day.
2 - LCSIS Administrator’s Application Guide
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Preface

VISIBLE LCSIS is a dynamic application that unites a set of data and process manage-
ment tools into an integrated product data management system that supports ISO 9000 
quality standards.  VISIBLE LCSIS optimizes a company’s ability to manage its concur-
rent product development environment by providing advanced configuration manage-
ment, links to non-technical support areas, workflow management, and flexible viewer 
interfaces. 

This guidebook focuses on the VISIBLE LCSIS administrator.  The intent is to provide 
useful guidelines about the VISIBLE LCSIS application, to provide procedures for VISI-
BLE LCSIS system administration, and to provide appropriate references to specific pro-
cedures already covered in existing documentation.  The guidebook begins with a 
discussion of how VISIBLE LCSIS works, explains how the application is installed, pro-
vides references for database maintenance, and provides procedures that will help the 
application administrator help VISIBLE LCSIS users.  In addition, we provide guidelines 
for producing standard and ad hoc reports and discuss special features of VISIBLE LCSIS 
that may be of interest to the application administrator.  Finally, technical support informa-
tion is provided. 
LCSIS Administrator’s Application Guide- 3
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Visible Systems
1 ....How VISIBLE LCSIS Works 

The VISIBLE LCSIS product data management application is the point of entry for a set 
of integrated computer programs designed for manufacturing firms that have complex 
data management requirements, in-house systems administration, and network resources.  
The VISIBLE LCSIS application assumes a familiarity with Windows workspaces and the 
User’s Guide and this Administrator’s Guide may be used in concert with appropriate 
Windows User Guides to achieve maximum functionality and benefits.  In order to pro-
vide experienced Windows users with an intuitively familiar workspace, VISIBLE LCSIS 
generally conforms to the guidelines contained in The Windows Interface Guidelines for 
Software Design.  

VISIBLE LCSIS unites a set of data and process management tools into an integrated 
product data management system that supports ISO 9000 quality standards.  VISIBLE 
LCSIS optimizes a company’s ability to manage its concurrent product development envi-
ronment by providing advanced configuration management, links to non-technical support 
areas, and workflow management.  VISIBLE LCSIS uses a graphical user interface (GUI) 
to create an environment that is easy to learn and easy to operate.  Users launch VISIBLE 
LCSIS by clicking on an icon at their own workstation; integration with other applications 
is transparent to the user.

VISIBLE LCSIS is used within an enterprise to organize, access, and control all data 
related to its products and to mange the life cycle of those products.  To accomplish this, 
VISIBLE LCSIS accommodates administrators, end-users that create or modify product 
information, non-technical support personnel, and program managers.  Through the Data 
Repository Module, the data vaults complement and support configuration management 
requirements by linking data files and product documentation to the product’s configura-
tion for total document management and version control.  VISIBLE LCSIS is a proactive 
step toward ISO 9000 compliance.  VISIBLE LCSIS promotes on-line workflow manage-
ment through its Project Management Module.  Workflow allows users to monitor and 
repeat successful processes.  This enables managers to optimize resource utilization 
through reliable performance tracking.  The VISIBLE LCSIS Master Configuration Mod-
ule allows users to access family trees that display data for existing products.  Product line 
variants are supported through As-Modified Baselines and uniquely serialized component 
tracking.  The Life Cycle Module performs change control functions.  VISIBLE LCSIS 
provides users with the capability to compile and print useful reports that reflect the prod-
LCSIS Administrator’s Application Guide- 5



1 How VISIBLE LCSIS Works 
uct and its status.  Users have fast access to meaningful change control and status account-
ing information.

Data Repository Module
VISIBLE LCSIS is unique because it responds to configuration management requirements 
by providing total document management and version control.  The three VISIBLE LCSIS 
vaults, which are similar in architecture and operation, are designed to provide storage of, 
and controlled access to, the following categories of data:

• PRODUCT DATA - Product-related documents (such as engineering drawings) that 
are required by a large number of users to perform assigned product data management 
tasks.

• GENERAL DATA - Common interest documents (such as industry standards or forms) 
that have wide applicability to an organization.

• USER DATA - Any document of particular interest to the user (such as personal mem-
oranda, schedules) to which the user may grant others access on a case-by-case basis.

The principle underlying the architecture of the product and general vaults is that the max-
imum number of users are provided viewing access to product-related and common inter-
est documents, while check-out privileges are granted only to those actually authorized to 
make changes to those documents.  VISIBLE LCSIS allows selected users to check-out, 
or change (check-in) data sets, documents, and other product information, and maintains 
multiple releases and user authorizations.  This critical function is based on what each user 
is authorized to do within the system; once the user is cleared by the system, the system 
will perform the check-in/out action as requested.

Check-in occurs when a product design is created, modified, or promoted and is placed 
under VISIBLE LCSIS control.  When a product data element is checked in, full security, 
access control, and change control will be effective.  When a product element is modified 
and the modification is approved, it will be checked in as a newly released revision.  
Check-out occurs when controlled product information is required by a user to use without 
change, to modify or change, to view, or to red-line, markup, or comment that product 
information item.  During check-outs, the vault locks the original information to prevent 
users from changing or modifying the data simultaneously.

Project Manager Module
The VISIBLE LCSIS workflow function provides users with tools to define and imple-
ment change processes and workflows based on site-defined rules.  Workflow provides 
6 - LCSIS Administrator’s Application Guide
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VISIBLE LCSIS users with a flexible set of tools for handling projects ranging from 
structured, high-volume, transaction-based processes that are relatively static in nature to 
individualized, ad-hoc processes that evolve from small, dynamic workgroups.  VISIBLE 
LCSIS notification utilities automatically notify approvers of the need for their action.  
With the capabilities to identify, quantify, and repeat procedures, workflow provides a 
company with a path for continuous improvement.

Master Configuration Module
The Master Configuration Module provides the tools to develop, manipulate, and view the 
structure of any product logically.  This module generates the three document sets critical 
to developing, tracking, and updating, a product’s data throughout its life cycle: bills of 
material (BOM), configuration baselines, and family trees.  Configuration identification 
functions performed and controlled by this module include:

• As-planned, as-built, as-modified configurations,

• Maintenance history and revision tracking,

• Authorized manufacturer/supplier list,

• Serialized part tracking/effectivity by serial and date, and 

• Baseline comparison.

VISIBLE LCSIS allows users to create new structure elements for newly designed parts 
and assemblies, to create or delete a version, effectivity condition, substitute, or option for 
a part or assembly, and to browse up and down the product structure to find specific 
assemblies or parts.  Different users view BOMs, product configurations, and part lists 
structures differently.  To consider the impact of a proposed change to one part, a reviewer 
might use the product structure to find the other parts of the assembly to evaluate the 
effects of the change on those parts (used-on) and to find the other assemblies in which the 
part is used to evaluate the effect of the change on them (where-used).  VISIBLE LCSIS 
provides as-designed configurations for those users interested in viewing a functional 
hierarchical list.  VISIBLE LCSIS also provides as-built configurations for users who 
need to view the structure to see assembly information and relationships.

Life Cycle Module
Change control functions built into the Life Cycle module maintain secure control of doc-
umentation, allowing management to make informed decisions and allowing a company to 
respond effectively to circumstances leading to changes, improvements, and problem cor-
LCSIS Administrator’s Application Guide- 7



1 How VISIBLE LCSIS Works 
rection in product lines.  Improvements may be as simple as replacing an unreliable part, 
or as complex as redesigning an entire product line.  Products may be tailored to support a 
customer-defined specification for an existing product or introduce a totally new product.  
Approved change requests update affected product baselines simultaneously to enhance 
change/improvement response cycles.

Viewer Translator Module
VISIBLE LCSIS is bundled with a universal document viewer that allows enterprise-wide 
viewing and markup.  The user can view more than 150 file formats created from a multi-
tude of software packages and scanning devices.  Multiple documents can be viewed 
simultaneously in moveable windows; the viewer offers the user the capability to create, 
overlay, and redline files to allow data related to design changes to be relayed with the 
original documents.

Software Upgrades
VISIBLE LCSIS was developed to run with a relational database.  Upgrading the database 
system may affect VISIBLE LCSIS functionality. Please contact the VISIBLE LCSIS 
developer prior to upgrading your respective database.  

Database Operations and Maintenance 
Database management is the responsibility of an administrator who has had training on 
that system. Database operations and maintenance, at a minimum, should consider the fol-
lowing functions:  backup and recovery, user administration, monitoring the health of the 
database, controlling data updates, dealing with problems, and providing guidance to 
users.

Books from third party publishers can be useful guides to performing these functions.  For 
example, ORACLE backup and recovery functions, consult the ORACLE Backup and 
Recovery Handbook by Rama Velpuri.  To customize ORACLE and to fine tune it for per-
formance and productivity, see Tuning ORACLE by Michael Corey, Michael Abbey, and 
Daniel Dechichio, Jr.  Both books were published by ORACLE PRESS at Osborne 
McGraw-Hill, 2600 Tenth Street, Berkeley, CA 94710. 
8 - LCSIS Administrator’s Application Guide
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VISIBLE LCSIS Application Installation  
VISIBLE LCSIS is installed, configured, and tested by the developer’s implementation 
team.  Installation will create a directory (VISIBLE LCSIS) that contains the executable 
code (LCSIS.exe) and the required support files.  Implementation and system require-
ments are covered in more detail in the VISIBLE LCSIS User Guide, chapter 2.

The complete VISIBLE LCSIS installation includes a database program, a vault manage-
ment program, a multiformat viewer, and a networking software package in addition to the 
visible LCSIS application. Once the client and server applications have been loaded, VIS-
IBLE LCSIS appears as a single program to the user.

VISIBLE LCSIS operates on a PC Client running Windows configured and running TCP/
IP software. VISIBLE LCSIS is supported by MS SQL/Server installed on a Pentium 
server with Windows NT/2000/XP OS using TCP/IP protocols.  VISIBLE LCSIS uses 
Myriad as its multi-format viewer.  

VISIBLE LCSIS System Architecture

Vault

Visible 
LCSIS

Database
Operating
System

Operating System

SQL
Net

NFS
Client

TNS
(TCP/IP)

NFS
(TCP/IP)

Server Components:
Operating System - Microsoft Windows NT/2000/XP

Client Components:
Operating System - Microsoft Windows
 / TCP/IP networking
LCSIS Administrator’s Application Guide- 9



1 How VISIBLE LCSIS Works 
10 - LCSIS Administrator’s Application Guide



Visible Systems
2 ....Supporting VISIBLE LCSIS 
Users

Logging In
Logging in is illustrated in more detail in the VISIBLE LCSIS User Guide, chapter 3.  Two 
levels of startup security and access control are provided in VISIBLE LCSIS:

• Client-Server Connectivity -- Established during startup of the client, this requires a 
password assigned by the Network Administrator in accordance with previously 
established procedures.

• VISIBLE LCSIS Application and Database Access -- Established upon startup of VIS-
IBLE LCSIS, this requires a password initially assigned by the VISIBLE LCSIS 
Application Administrator. Users will be granted access to VISIBLE LCSIS modules 
based on functional roles and/or task assignments as authorized by the Application 
Administrator. 

Changing Passwords
Passwords (maximum 10 characters) are initially assigned by the Application Administra-
tor, but may be changed by an authorized user during any login process. 

Maximum Number of Users
If the maximum number of seats authorized for an installed system are already on line, an 
informational message box will appear listing all active users and the times of their logins. 
An authorized user may be logged in concurrently at more than one location.  To increase 
the maximum number of VISIBLE LCSIS users on the system, call Technical Support 
(see “Technical Support and Maintenance Agreement” on page  53).
LCSIS Administrator’s Application Guide- 11
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3 ....VISIBLE LCSIS Application 
Administration

These guidelines provide a description of the screens that comprise one of the VISIBLE 
LCSIS application’s principal features, the System Administration module, along with 
detailed instructions for their use. Because the reliability of the product data and process 
management tools incorporated in the application and the fidelity of the information 
stored in the VISIBLE LCSIS database are only as secure as the protection provided to 
both of these functions, it is recommended that distribution of this document be limited to 
a minimum as determined by the designated Application Administrator.

The System Administration (Admin) module is the primary VISIBLE LCSIS interface for 
establishing the identities and access privileges of the individual users of the application, 
as well as for establishing their relationships. It also provides utility functions for adminis-
trative editing of data entered into the VISIBLE LCSIS database, ranging from the correc-
tion of simple typographical errors to the deletion of entire baselines.

Admin Drop-down Menu
The options available in the Admin drop-down menu are illustrated in the next figure.
LCSIS Administrator’s Application Guide- 13



3 VISIBLE LCSIS Application Administration
Admin Drop-down Menu

Accounts
Clicking on Accounts in the Admin drop-down menu provides the Application Adminis-
trator access to a set of screens used to establish individual user accounts and to establish 
relationships among those users. The options available in the Accounts submenu are illus-
trated in the following figure.
14 - LCSIS Administrator’s Application Guide



Visible Systems
Admin Drop-down Menu with Accounts Submenu Displayed

Company Detail
Clicking on Company Detail in the Accounts submenu of the Admin drop-down menu 
accesses a screen (illustrated in the following figure) that is used to enter own company 
information into the VISIBLE LCSIS database.
LCSIS Administrator’s Application Guide- 15



3 VISIBLE LCSIS Application Administration
Company Detail Screen

User Accounts
The User Accounts screen, an example of which is shown in the next figure, is used to 
enter/display information concerning all authorized users of the VISIBLE LCSIS applica-

NOTE: The CAGE (Commercial and Government Entity) Code is a unique five-
character company identification number issued by the Defense Logistic 
Agency (DLA) to identify Department of Defense contractors. Together, a part 
number and CAGE code comprise a unique identifier for every assembly and 
part, including the Top Assembly, within VISIBLE LCSIS. It is mandatory that 
every part number have a corresponding CAGE code. If your company does 
not have a DLA-assigned CAGE code, this field must contain a company-
unique identifier prior to the creation of a BOM or baseline. The code recorded 
in the Company Detail screen will automatically be entered for every part/
assembly designated Build (vice Buy) during data entry.)
16 - LCSIS Administrator’s Application Guide
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tion. It is accessed by clicking on User in the Accounts submenu of the Admin drop-down 
menu.

User Accounts Screen

Screen Description
This screen is divided into two major sections. On the left (User Data) side of 
the screen are listed the login identification, password, name, and status of each 
authorized user. On the right (Permissions) side of the screen are check boxes 
indicating to which of the VISIBLE LCSIS modules each individual has been 
LCSIS Administrator’s Application Guide- 17



3 VISIBLE LCSIS Application Administration
granted access. The order of information on this screen may be rearranged by clicking on 
the Sort toolbar button and selecting the criteria for the sort, e.g., sorting by Username will 
list all authorized users in ascending alphabetical order, as shown in the preceding figure.

Establishing User Accounts

To establish a new user account, the Application Administrator first clicks on Insert User 
in the Edit drop-down menu to open a line of User Data text/ drop-down list boxes and 
Permissions check boxes for assigning a unique set of credentials and privileges to that 
user.

• �Login ID -- Type in user-unique identifier. This may be any set of up to 10 alpha-
betical, numerical, alphanumeric, or keyboard characters. Examples include first 
name, last name, employee number, personal alias, etc.

• �Password -- Type in user-unique countersign (i.e., personal identifier, or PID). 
This may be any set of up to 10 alphabetical, numerical, alphanumeric, or keyboard 
characters, assigned in accordance with company management information system 
security policies. 

NOTE: The Application Administrator is the only user authorized access to the 
Administration module, therefore, that option is not listed in the Permissions 
section of the screen.

NOTE: As an additional security measure, passwords are not displayed on this 
screen since the VISIBLE LCSIS Login dialog box allows the user to change 
his/her own password at any time. Should the Application Administrator find it 
necessary to change a user’s password, he/she should type in the replacement 
password in the text box next to the user’s Login ID. That new password will 
remain valid until changed by the user or the Application Administrator.
18 - LCSIS Administrator’s Application Guide



Visible Systems
• �Username -- Enter gender of user by clicking on appropriate choice in the drop-
down list box, and then type in the actual name of the user, entering the last name 
first to facilitate alphabetical sorting of names in VISIBLE LCSIS windows. 

• Status -- Upon installation of VISIBLE LCSIS, an Application Administrator will be 
designated, who will be the only user to have access to the System Administration 
(Admin) module. All other authorized VISIBLE LCSIS users will be assigned the sta-
tus of User automatically.

�

Once an individual user account has been established, the Application Admin-
istrator assigns that user access privileges to the desired modules by clicking on 
the corresponding check boxes in the Permissions section of the screen. Click-
ing on the Save toolbar button completes the process and saves the data to the 

VISIBLE LCSIS database.

Deleting User Accounts

To delete a user account, the Application Administrator first selects the user to be deleted 
on the User Accounts screen and then clicks on Delete User in the Edit drop-down menu. 
A query dialog box will appear requesting confirmation of the deletion. Clicking on the 
Yes command button will delete the user. 

NOTE: Upon installation, the initial account established will be for the Applica-
tion Administrator under the gender-neutral username of “Administrator, VISI-
BLE LCSIS.” For purposes of illustration, this manual shows similarly formatted 
usernames, e.g., “Manager, Product,” but this method of aliasing is discour-
aged insofar as it can seriously degrade quality system record-keeping efforts, 
such as those required by ISO 9000.

NOTE: If the user is involved in any workgroup/workflow activities or is the 
owner of any vaulted documents, he/she cannot be deleted until all such 
actions/data have been reassigned. An information message similar to that 
shown in the next figure will apprise the Application Administrator of this situa-
tion.
LCSIS Administrator’s Application Guide- 19



3 VISIBLE LCSIS Application Administration
Delete User Status Information Message Box

Reassigning Document Ownership

To reassign ownership of a set of documents to another or several other authorized VISI-
BLE LCSIS users, click on Reassign Document Ownership in the Edit drop-down menu, 
which will cause a dialog box similar to that shown in the next figure to appear. 

NOTE: This utility accommodates transfer of document ownership within a spe-
cific documentation category (e.g., those that currently are part of an open 
process within the Product Improvement module) belonging to a user who is no 
longer part of the organization, e.g., reassignment, termination, etc., or who will 
be absent for an extended period of time, e.g., vacation, illness, travel, etc.
20 - LCSIS Administrator’s Application Guide
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User Accounts Screen with Reassign Document Ownership Dialog Box Cascaded

A text box in the upper portion of the dialog box displays the username selected in the 
User Account screen, i.e., the current owner of the documents to be reassigned. The center 
section contains a list of the four categories of documentation subject to reassignment:

• Change Control -- Trouble report or change request documents, including deviation 
and waiver requests, involved in a review process currently in progress within the 
Improvement module.

• Vault -- Documents residing in any of the three VISIBLE LCSIS Data Vaults.
LCSIS Administrator’s Application Guide- 21



3 VISIBLE LCSIS Application Administration
• Workbasket -- Documents currently in the user’s Workbasket.

• Workflow -- Documents involved in a review process currently in progress within the 
Workflow module.

To transfer ownership of all the selected user’s documents within any one of these four 
categories, click on the check box adjacent to the category, and then click on the username 
of the new owner in the Assign to Username drop-down list box to the right of that check 
box. Complete the reassignment process by clicking on the Reassign command button in 
the dialog box.

Status
Clicking on Status in the Admin drop-down menu provides the Application Administrator 
access to a set of screens used to display the present status of baseline and document trans-
actions and the current location and status of Workbasket-transmitted actions. The options 
available in the Status submenu are illustrated in the following figure.

NOTE: A different new owner may be designated for documents in each of the 
categories selected.
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Admin Drop-down Menu with Status Submenu Displayed

Transaction Reports
VISIBLE LCSIS is capable of generating a listing of all baseline and document transac-
tions that have occurred within a user-specified timeframe, systematically arranged in a 
report format. Clicking on Transaction Report in the Status submenu of the Admin drop-
down menu accesses a Preview - Transaction Report screen, an example of which is illus-
trated in the next figure.
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3 VISIBLE LCSIS Application Administration
Preview - Transaction Report Screen

The top portion of this screen contains text boxes for entering the start and end 
dates for the desired report. After these dates have been entered, clicking on the 
Preview command button displays information concerning every baseline and 
document transaction that took place during the specified period in the lower 

portion of the screen. This information may be viewed on screen using the vertical and/or 
horizontal scroll bars/arrows, or may be printed by clicking on the Print toolbar button or 
clicking on Print in the File drop-down menu.
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Workbaskets
VISIBLE LCSIS is capable of generating a tabular listing of all current Workbasket activ-
ity by location and Clicking on Workbaskets in the Status submenu of the Admin drop-
down menu accesses a Workbaskets screen similar to that shown in the following figure.
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3 VISIBLE LCSIS Application Administration
Workbaskets (Status) Screen

This screen shows the subject, originator, and addressee of every open Work-
basket action, as well as the date the message was received, the date a reply/
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action is due, and the status of the message in the Workbasket of the addressee. The order 
of information in this table may be rearranged using the Sort toolbar button.

Utilities
Clicking on Utilities in the Admin drop-down menu provides the Application Administra-
tor access to a set of screens used to correct information in the VISIBLE LCSIS database, 
e.g., data entry typographical errors, omissions, etc., without having to go through the 
change control process. The options available in the Utilities submenu are illustrated in the 
following figure.

Admin Drop-down Menu with Utilities Submenu Displayed

Modify Part Data
The Modify Part Data screen allows the Application Administrator to correct part details 
in the VISIBLE LCSIS database without having to invoke the change control process. 
This utility averts the necessity for creating change processes/documents merely to correct 
errors made during creation of a BOM/baseline, e.g., incorrectly entered category, type, 
and source (including manufacturer CAGE code) information, as well as to add comments 
concerning the part. Clicking on Modify Part Data in the Utilities submenu of the Admin 
drop-down menu will open a screen similar to that depicted in the next figure.
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Modify Part Data Screen

To change any detail describing the selected part number, type in the correct information 
(e.g., Description, Revision, Comments) or click on the drop-down list box for the detail 
and select an alternative value. When finished, click on the Modify command button to 
save the changes to the VISIBLE LCSIS database. VISIBLE LCSIS will automatically 
update the Parts Catalog screen and will notify Product Managers of the changes via their 
respective Workbaskets.
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Modify BOM/Baseline
The Modify BOM/Baseline screen allows the Application Administrator to correct infor-
mation in an existing BOM/baseline without having to invoke the change control process. 
This utility averts the necessity for creating change processes/documents merely to correct 
data errors introduced during creation of a BOM/baseline, e.g., incorrect identification or 
omission of an assembly/part, entry of incorrect units of measure or quantities within a 
given assembly, etc.

Clicking on Modify BOM/Baseline in the Utilities submenu of the Admin drop-down 
menu will open the Modify BOM/Baseline screen with page tabs, an example of which is 
shown in the next figure with the Effectivity tab page displayed.
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Modify BOM/Baseline Screen with Effectivity Tab Page Displayed

Effectivity

The upper portion of the Effectivity tab page on the Modify BOM/Baseline screen contains 
a drop-down list box for selecting the part number of the next higher assembly (NHA) 
containing the item(s) to be modified, a text box showing the item’s CAGE code, and a 
static text field displaying the NHA’s description. Text boxes also are provided for desig-
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nating the effectivity parameter (date or serial number) and the date (current unless other-
wise specified) for any As Built baselines being changed.

The remainder of the Effectivity tab page is divided into the following sections:

• Subassembly/Part Effectivity -- Used to identify any subassemblies and/or parts that 
would be added, deleted, or modified by the correction.

• Product Effectivity -- Used to designate all baselines (and BOMs for which baselines 
have not been created) in which the correction is to be made.

• Serial Effectivity -- Used to designate the range of serialized assemblies affected by 
the correction and the first serial (break-in point) affected.

Upon accessing the Effectivity tab page, click on the part number of the NHA to be modi-
fied in the drop-down list box in the upper portion of the screen. VISIBLE LCSIS will 
automatically insert the NHA’s description in the text box provided. If As Built baselines 
are to modified, click on Date or Serial Number in the �Effectivity By drop-down list box, 
as desired. If the current date is appropriate, proceed to the lower portions of the tab page 
to enter the necessary changes and to designate the affected baselines; if not, type in a new 
date in the �Effectivity Date text box before proceeding.

To add a new part, click on Insert Part Effectivity in the Edit drop-down menu. VISIBLE 
LCSIS will automatically insert Add in the �Code column of the new line and will dis-
play a drop-down list box containing the part numbers of all part numbers in the VISIBLE 
LCSIS database. After selecting a part number in the drop-down list (at which point VISI-
BLE LCSIS will automatically insert the name of the part in the Description column), type 
in the quantity and unit of measurement in the �Qty and �U/M columns, respectively.

NOTE: Since the purpose of this utility is to administratively modify incorrect 
data already under configuration control rather than to change that data as the 
result of an approved change control process, this tab page differs from that 
used in the Product Improvement module in that this Effectivity tab page does 
not contain a section referencing any documentation governing the change, 
precisely because there will not be any. For this reason, users should exercise 
caution when making changes to derivative (As Built) baselines in the Modify 
BOM/Baseline screen, since those derivative baselines may differ from their 
parent (As Planned) baselines without any reference to the reason for the vari-
ances.
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To delete a part, select Del(ete) in the �Code column next to the subassembly/part 
number. If the deleted part is to be replaced, click on the �Code column again, but this 
time select Add. VISIBLE LCSIS will open a new line for entering replacement part data 
and will automatically insert the part number of the deleted part in the Replaces Part col-
umn. 

To change the quantity or unit of issue, click on Mod(ify) in the �Code column next to the 
affected subassembly/part number and type in the new quantity and/or unit of measure-
ment in the �Qty and �U/M columns.

The lower left corner of the Effectivity tab page will display all baselines (and BOMs for 
which baselines have not been created) in which the assembly/part occurs. Click on the 
checkbox next to each baseline affected by the correction.

The lower right corner of the Effectivity tab page will display all serial ranges assigned to 
the baseline highlighted. The user may indicate the range of serial numbers to be affected 
in one of two ways. If the correction is required starting with a serial number in a dis-
played range, type that serial number in the Break-In column for that range. If the correc-
tion will affect only a portion of that range, even if only one unit, click on Insert Serial 
Effectivity in the Edit drop-down menu, and then type in the start, end, and break-in serial 
numbers in the respective text boxes provided. In this case the start and break-in numbers 
should be the same. To delete serial ranges in the specified baseline that will not be 

NOTE: If the part number being added to this subassembly is not in the VISI-
BLE LCSIS database, it will be necessary to define the new subassembly/part 
before proceeding by clicking on the Build Assembly tab. �See below for a full 
description of the Build Assembly tab page (see figure ‘Modify BOM/Baseline 
Screen with Effectivity Tab Page Displayed’ on page  30) and instructions for its 
use.

NOTE: The replacement part also may be entered by clicking on Insert Part 
Effectivity in the Edit drop-down menu (� see above), but the user must type 
in the part number of the replaced part manually.

NOTE: In all cases, the As Planned baseline (or BOM, if no baseline has been created) 
must be selected.
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affected by the correction, click on (highlight) the serial range and then click on Delete 
Serial Effectivity in the Edit drop-down menu. A warning dialog box will appear request-
ing the user to confirm the deletion before proceeding.

Build Assembly

The Build Assembly tab page permits definition of a new or replacement subassembly not 
in the VISIBLE LCSIS database. 

If the modification is to add a new or a replacement subassembly/part that was not in the 
VISIBLE LCSIS database, the new item must be defined before proceeding. To accom-
plish this the user should begin by clicking on the Build Assembly tab, which will open a 
tab page similar to that shown in the next figure.

NOTE: Allowing the user to define an assembly within the processes of this utility is 
intended to permit correction of an administrative omissions that occurred during base-
line creation, rather than to circumvent the change control process provided in the 
Product Improvement module. Any modifications made through this tab page will not 
be documented.
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Modify BOM/BaselineScreen with Build Assembly Tab Page Displayed

The Major Assembly (upper left hand corner) section of the tab page provides an open text 
box for typing in the part number of the highest level assembly being defined. The other 
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three sections of this tab page contain text boxes for entering detailed data about that 
assembly and all of its subassemblies/parts. The Edit drop-down menu (shown in the next 
figure) provides options for adding, defining, and/or removing assemblies and/or sub-
assemblies on this tab page.
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Edit Drop-down Menu for Build Assembly Tab Page for Modify BOM/Baseline Screen

The user should begin by clicking on Insert Major Assembly in the Edit drop-down menu, 
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which will result in a dialog box appearing offering the user the choice of copying data 
from another assembly in the VISIBLE LCSIS database. If no similar item is known to 
exist, the user should click on the No command button and proceed to the tab page to 
define the new assembly.

Data should be entered beginning with the highest level and working downward through 
the hierarchy in order to establish the parent-child relationship for each subassembly/part 
and its next higher assembly (NHA). This linkage is accomplished by first clicking on the 
part number of the NHA of a subassembly/part to be inserted/copied in the Assembly col-
umn before using the Edit menu to insert/copy a part number into the Subassembly sec-
tion.

If the part number is for an assembly being copied, VISIBLE LCSIS automatically will 
simultaneously copy the subassembly’s part number and CAGE code into the Assembly 
column, along with the part numbers and CAGE codes of all of its subassemblies, and also 
will copy the detail information on all of its components. If the part number being inserted 
is for an item not previously in the VISIBLE LCSIS database, the user types in the part 
number, CAGE code, quantity, and unit of issue for each subassembly/part in the appro-
priate blank text boxes in the Subassembly section of the Modify BOM/Baseline tab page. 
After entering this information for a given subassembly/part in the center portion of the 
tab page, the user proceeds to the Detail section, where he/she may accept all of the 
default settings, or may change any by clicking on the appropriate alternative in the corre-
sponding drop-down list box or by typing the desired description or comment in the 
applicable text box.

When one or more assemblies have been copied from an existing baseline, the user may 
then employ the Edit drop-down menu (illustrated in the next figure) to add or delete sub-
assembly and/or part information required to distinguish the characteristics of items in the 
new BOM/baseline, including quantities and units of issue, from those of the BOM/base-
line from which it was copied.

When performing any of these functions, it is important to bear in mind that all items from 
an existing BOM/baseline were (and still are) under configuration control. When a part 
within a product is changed so that it is no longer interchangeable with its previous ver-
sion (i.e., it does not match in form, fit, and function), it must be assigned a new identifier 
before the change can be made. The standard rule is to reidentify the NHA and all subse-
quent higher assemblies up to and including the level at which interchangeability is re-
established. This should be done beginning with the highest indenture level affected and 
working down through the hierarchy. If this has not been done, a message box similar to 
that shown in the next figure will appear advising the user that the NHA must be reidenti-
fied before proceeding.
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Next Higher Assembly Status Information Message Box

Likewise, if a subassembly/part is deleted, the affected NHA is no longer interchangeable 
with its previous version, and its NHA must be assigned a new identifier before the dele-
tion can be made.

The following are the edit options available:

• Reidentify Assembly -- Allows user to reidentify any selected assembly in the Assem-
bly section. A dialog box similar to that illustrated in the next figure will appear 
requesting the user to type in a new identifier, and also to select in which of the 
NHAs the subassembly is to be reidentified.
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Reidentify Assembly Dialog Box with CAGE Code Drop-down List Box Displayed

Click on the �Select check box(es) beside the NHA (or NHAs) in which the subassembly 
is to be reidentified, and then click on the OK command button to return to the As Planned 
screen, which will reflect the reidentification of the selected assembly and/or assemblies.

• Delete Assembly -- Allows deletion of an assembly at any time prior to establishment 
of BOM/baseline. Since an assembly may be a subassembly in more than one NHA, 
VISIBLE LCSIS will present the user with a dialog box requiring that he/she identify 
from which NHA(s) the item is to be deleted by clicking on the appropriate check 
box.

• Insert Subassembly -- Opens a row of blank text boxes in the Subassembly section of 
the Modify BOM/Baseline tab page. (� See instructions for data entry and establish-
ing parent-child relationships above.)

• Copy Subassembly -- Allows reuse of any assembly in the VISIBLE LCSIS database 
as a subassembly in the NHA being defined. A dialog box will appear requesting the 
user to identify the BOM/baseline from which information about the assembly is to be 
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copied. (� See guidance concerning establishment of parent-child relationships for 
subassemblies above.)

Copy Assembly Dialog Box

• Delete Subassembly/Part -- Allows user to delete any subassembly or part. First, click 
on the part number of the subassembly’s next higher (parent) assembly in the Assem-
bly section of the tab page and then click on the part number of the subassembly/part 
to be deleted in the Subassembly section. Finally, click on Delete Assembly/Part in the 
Edit drop-down menu. If the subassembly/part can be deleted (� see above), a mes-
sage box will appear requesting confirmation of the deletion. Clicking on the Yes 
command button will complete the process, and will return the user to the Modify 
BOM/Baseline tab page, which will reflect the deletion of the subassembly and all of 
its components from the specified NHA.
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In the lower (Product Effectivity) section, click on the check boxes of all BOMs/baselines 
in which corrections are to be made. All As Planned BOMs/baselines must be selected. If 
the corrections for a selected As Built baseline only apply to a set of serial numbers within 
that baseline, use the Edit drop-down menu to open a set of text boxes for inserting a serial 
range and a break-in point (serial number), if applicable.

When completed, click on the OK command button. At that point a warning dialog box 
similar to that shown in the next figure will appear advising the Application Administrator 
of the consequences of this action and requesting confirmation of the command.

Implement Changes Warning Dialog Box

Clicking on the Yes command button completes the process. Corrections will be made to 
all baselines designated, and VISIBLE LCSIS will automatically notify the Product Man-
agers and Data Managers for the affected baselines of the changes via their respective 
Workbaskets.

Delete BOM/Baseline
Under certain circumstances the Application Administrator may find it necessary to delete 
a bill of material or a baseline, e.g., one that is incomplete due to a system error during 
creation, one that is redundant, or one that has not been nor ever will be put into produc-
tion. The Delete BOM/Baseline screen provides the Application Administrator with this 
capability, subject to certain restrictions (� see below).

Clicking on Delete BOM/Baseline in the Utilities submenu of the Admin drop-down menu 
opens the Delete BOM/Baseline screen, an example of which is shown in the next figure.
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Delete BOM/Baseline Screen

Screen Description

The upper portion of this screen contains text boxes for selecting the product line, model, 
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top assembly, type, and configuration identification (if applicable) of the BOM or baseline 
to be deleted. The lower portion (Baseline Data) of the screen displays data for that BOM/
baseline for reference.

Deleting BOMs or Baselines

Any BOM or baseline can be deleted, as long as no changes have been proposed against in 
the Product Improvement module. An information dialog box similar to that shown in the 
next figure will appear advising the user if this is the case.

Baseline Status (Change Documents Submitted) Information Dialog Box

Existing BOMs and baselines must be deleted in the inverse order in which they were cre-
ated, i.e., before deleting an As Built baseline, all As Modified baselines derived from it 
must be deleted; and before deleting an As Planned baseline, all As Built baselines 
derived from it must be deleted. If derivative baselines exist for the baseline selected for 
deletion, an information message box, similar to that depicted in the following figure, will 
appear.

Derivative Baseline Status Information Message Box

To delete the selected BOM or baseline, click on the OK command button on the Delete 
BOM/Baseline screen. As a final check of the user’s intentions, a warning dialog box (sim-
ilar to that shown in the next figure) will appear asking for confirmation.
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Baseline Deletion Warning Dialog Box

Clicking on the Yes command button permits the deletion process to continue. When the 
BOM or baseline has been deleted, a message box similar to that illustrated in the next fig-
ure will confirm the action.

Baseline Deleted Information Message Box

Reidentify Document
The Reidentify Document screen allows the Application Administrator to change the iden-
tifier of any change document. This capability provides the user with an easy method for 
bringing existing change documents into compliance with whatever identification scheme 
is currently in use.

NOTE: If all Top Assemblies under a given Product Line/Model 
combination have been deleted, the user also may delete that 
Product Line/Model in the Product Development (Develop) mod-
ule (� see Visible LCSIS User’s Guide, Chapter 6, Product 
Development).
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Reidentify Document Screen
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To reidentify a change document, click on the document and type in a new document 
identification in the text box provided. Clicking on the OK command button will change 
the document’s identifier in the VISIBLE LCSIS database. 

NOTE: Changes on the Reidentify Document screen itself will not be reflected until the 
screen has been exited and recalled.I
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4 ....VISIBLE LCSIS Reports

Standard Reports
VISIBLE LCSIS provides the user with the capability to view on-screen and/or print out a 
series of useful reports containing the latest product data compiled from the most fre-
quently used screens in the Product Information (Info) module.  Clicking on Reports in the 
Info drop-down menu will access a report selection screen.
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Report Selection Screen
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Screen Description
The upper portion of the screen contains drop-down list boxes for selecting the product 
line, model, and top assembly, as well as the type (As Planned, As Built, or As Modified) 
of BOMs/baselines, and the configuration identification of the As Built or As Modified 
end item for which the report is desired.  The lower portion of the screen contains a list 
box for selecting the type of report, check boxes for selecting the types of change docu-
ments to be included in a given report, and command buttons for initiating or canceling the 
report generation process.

Processing Reports
To process any of the reports listed below, begin by clicking on the desired product line, 
model, top assembly, type, and configuration identification (if applicable) in the upper 
portion of the Reports screen.  Then click on the subject of the report desired in the list box 
in the lower left portion of the screen. 

When all selections have been completed, the user can then click on the Preview com-
mand button to view the selected report on screen.  Each Report Preview screen will dis-
play the report as it would be printed.  Each report will contain the product line, model, top 
assembly, type, and configuration item (if appropriate) selected, as well as the following 
information about the report itself: the name of the user initiating the report; the number of 
pages the report contains; and the date of report.  Use the vertical scroll bar to view all of 
any page, and press <Page Down> or <Page Up> to move from one page of a multi-paged 
report to another.

A summary description of each report is provided below.  A more complete description of 
each report along with supporting illustrations is provided in the VISIBLE LCSIS User’s 
Guide.

(1)  Assembly Serialization Report

An Assembly Serialization Report will show each serialized top assembly manufactured 
to date in the selected As Modified baseline, and the serial number of every serialized sub-
assembly installed in each, along with the revision, description, and date of installation for 
each subassembly.  In addition, every change proposed for a serialized top assembly will 
be listed, by document number, along with its status and date of status, and the baseline 
break-in point and range (end serial number). 

(2)  Baseline Report

A Baseline Report will show the entire physical item hierarchy, including all supporting 
documents for each item in the hierarchy, for the selected model/configuration identifica-
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tion, formatted in the following columns: Part Number; Revision; Description; Quantity; 
Unit of Measure; and Next Higher Assembly (NHA).  

(3)  Baseline Comparison Report

The Baseline Comparison Report will show all differences between two selected base-
lines.  The first of the two baselines to be compared will be the one selected in the upper 
portion of the Reports window, and clicking on the Preview command button will open a 
Compare Baselines dialog box.

After selecting the second baseline in the dialog box, click the OK command button to ini-
tiate the comparison.  The part numbers contained in each column are components of that 
particular baseline, but not of the other.  

(4)  Bill of Material Report

A Bill of Material Report will show the entire physical item hierarchy for the selected 
model/configuration identification formatted in the following columns: Part Number; 
Revision; Description; Quantity; Unit of Measure; and NHA.  

(5)  Change Status Report

A Change Status Report will show the status of all change documents (in those categories 
that were selected in the check boxes on the Reports screen, i.e., approved, new, pending, 
etc.) that affect every assembly, subassembly, and/or part in the selected configuration 
identification of the end item.  The following information concerning each change docu-
ment will be included in this report:

• Document Number -- Unique identifier assigned to document.

• Type -- Nature of document, i.e., change request, trouble report, waiver, deviation, or 
field modification.

• NOR/SCN Number -- Unique identifier assigned to notice of revision (NOR) or speci-
fication change notice (SCN).

• Assembly Number -- Part number of assembly affected by change.

• Status -- Progress of document in review process, e.g., pending, approved, disap-
proved, etc.

• Status Date -- Date of action in Status column.

• Implementation Code -- Status of approved change implementation, i.e., has affected 
documentation been revised: Yes or No.
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• Implementation Date -- Date of change implementation.

• Old Rev -- Superseded revision designator.

• New Rev -- Revision designator resulting from implementation of change.  (A plus (+) 
in this column indicates that a change has been approved but has not been imple-
mented.) 

(6)  Family Tree Report

A Family Tree Report will show the indentured physical item hierarchy for the selected 
model/configuration identification formatted in the following columns: Level; Part 
Number; Revision; Description; Quantity; Unit of Measure; and NHA.  In addition, the 
status of all existing change documents (in the categories selected in the check boxes on 
the Reports screen) for each part number will be shown below the part number. 

(7)  Field Modifications Report

A Field Modifications Report will show all field modification documents that affect the 
selected As Modified baseline.  The following information concerning each change docu-
ment will be included in this report:

• Serial Number -- Identifier of top assembly affected by the field modification.

• Date -- Date serial number assigned to assembly.

• Customer -- Client for whom top assembly was built.

• Status -- Approved or in progress.

• Date -- Date of action in Status column.

• Comments -- Any additional information concerning field modification.

After selecting the affected baseline in the upper portion of the Reports screen, click on 
Field Modifications in the Report Name selection list, and then click on the desired modi-
fications (i.e., accomplished and/or in progress) in the Field Documents check boxes.  

Clicking on the desired modification and the OK command button will cause the Field 
Modifications Report to be displayed on a Report Preview screen.

(8)  Part Status Report

A Part Status Report is similar to a Change Status Report in that it will show the status of 
change documents affecting a baseline.  However, whereas the Change Status Report will 
reflect change documents for every assembly, subassembly, and/or part in the selected 
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configuration identification of the end item, the Part Status Report only shows the status of 
change documents (in those categories that were selected in the check boxes on the 
Reports screen, i.e., approved, new, pending, etc.) affecting a single, specific part number.  
Clicking on the Preview command button on the Reports screen opens a Select Part 
Number dialog box that is used to locate/select the subject part in the designated baseline.

Once the part has been located in the dialog box, clicking on the OK command button will 
cause the Part Status Report to be previewed on screen. 

(9)  Vault Documents Report

VISIBLE LCSIS is capable of generating a report showing a complete, systematically 
arranged listing of every document in the Product Vault affecting a given baseline.  

As do all of the Report Preview screens, the top portion of this screen contains information 
about the subject of the report, as well as about the report itself.  The lower portion of the 
screen displays an indented listing of every document contained in the Product Vault for 
each displayed part number in the selected baseline, arranged in a multi-tiered, column 
format.

(10)  Where Used Report

The Where Used Report will show every next higher assembly (NHA) in which a selected 
subassembly or part is used within a given product line, model, top assembly, and config-
uration identification (for As Built baselines).  Clicking on the Preview command button 
on the Reports screen opens a Select Part Number dialog box that is used to locate/select 
the subject part in the designated baseline.  Once the part has been located, clicking on the 
OK command button will cause the Where Used Report to be previewed on the screen. 

(11)  Project Status Reports

The Project Status Report allows the user to view the status of any VISIBLE LCSIS Work-
flow project.  A Specify Retrieval Criteria dialog box will appear allowing the user to 
search for a particular project or view the status of all projects.  The upper portion of this 
screen displays the selected project’s name, description, start and end dates, and assigned 
workflow name.  A Folder command button provides access to all electronic files that 
have been placed in the project’s workfolder.  

To preview and print out a copy of a tabular formatted Project Status Report for any VISI-
BLE LCSIS Workflow project, click on Report in the Workflow drop-down menu.  A 
Specify Retrieval Criteria dialog box will appear allowing the user to search for a particu-
lar project or to view a report on the status of all projects. 
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Printing Reports
To print out all (or any range of pages) of one of these reports, click on the Print toolbar 
button or click on Print in the File drop-down menu, and define the scope of the printout 
in the dialog box that appears on screen.  (Note: A number of these reports, e.g., 
As Planned baselines for a complex model (parent assembly), may take some time to print 
out.  It is recommended that users give consideration to printing lengthy reports during 
off-peak usage hours.)

Technical Support and Maintenance Agreement
In accordance with the terms of the VISIBLE LCSIS Technical Support Software Mainte-
nance Agreement (if in effect), Visible will make all reasonable efforts to correct errors, 
malfunctions, and defects in the application.  Visible will provide the licensee with notice 
of all general updates to the application, including corrections of bugs and addition of 
minor enhancements, i.e., modifications to improve VISIBLE LCSIS performance, at 
least once a year.  Visible will provide fixes and correct bugs when an active maintenance 
agreement is in place.  Application enhancements related to performance improvements 
may be purchased from Visible.  However, Visible shall have no obligation to attempt to 
correct claimed errors if the licensee fails to incorporate any update provided.

Access to Visible support engineers is available during normal business hours (9 a.m. to 6 
p.m., Eastern time).  The telephone number is 1-(781) 778-0200.

Written requests for information or problem analysis may be obtained by mail, facsimile, 
or E-mail.  The mail address is Visible Systems Corporation, 201 Spring St., Lexington, 
MA 02421.  FAX queries may be transmitted to 1-781-778-0208 at any time.  E-mail que-
ries should be sent to VISIBLE LCSIS_support@visible.com.  Requests to correct errors, 
defects, or malfunctions that require in-depth analysis and troubleshooting must be 
accompanied by all relevant information, including input/output files and any supplemen-
tal files, to allow Visible technical support personnel to reproduce the error condition. 
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